Getting Started Tutorial for Wolfpack
Welcome to the latest edition to the Naval Campaigns series of games from John Tiller Software.
Wolfpack, the fifth title in the series, takes a huge leap forward over what has been offered previously.
The advanced submarine rules are a significant enhancement to the engine and allows a large number
of World War II actions to be covered that were not possible before.
This file helps you get started playing the game Wolfpack. If you have just finished installing the game,
then the Wolfpack main program should be running soon. Otherwise, you should start the main
program by clicking on the Main Program entry in the JT Software Wolfpack program folder (from the
Start Menu, select All Programs, then JT Software, and then the Wolfpack program group). If you have
installed the John Tiller Software Menu Program (http://www.johntillersoftware.com/Resources.php ),
you can also use that to launch the game. If you prefer, you can print these instructions. You will get
about 6 pages of text and graphics if you do this. You can get more detailed information by referencing
the General Help & User Manual linked within the “Help” menu of the game. Note: the Wolfpack
software is designed to run on displays with screen resolutions of at least 800 x 600 and with color
settings of 16-bit or higher.
By default, after the introduction, the Main Program begins by prompting you for the name of the file
to open using the File Selection Dialog. These instructions will get you started using #00_Getting
Started.scn. In the list of files displayed by the File Selection Dialog, this should already be selected.
Notice that a short description of the battle will appear at the bottom of the dialog. Also you can see
that this battle will last 1 hour of real-time. After reading this information, click on the OK button.

Next, the A/I Selection Dialog will appear. Wolfpack
plays very differently from the Allied and German sides
of the game. Therefore, the getting started scenario is
designed as an introduction for both sides. Since you
are going to play as the German side first, select
Automatic with FOW in the Allied A/I group on the
right hand side of the dialog. This will cause the
computer to play as the allied side. Then click on the
OK button. (When we return to play as the Allies, we’ll
reverse the settings, and set the German as A/I and the
Allied player as human.)
There are two versions of the User Interface, Classic
and Alternative. This tutorial will focus on the Classic UI which will be familiar those who have
played John Tiller naval games before. If you want to explore the second option you can choose it by
clicking on “Alternate Interface” in the Settings Menu.
In the lower left-hand corner of the screen, you will see the
Jump Chart which displays the overall situation. The red
dots will represent the German units. The blue dots represent
Allied units that you can currently see, although there may
be others outside of your range of visibility. We start a bit
out of range of the British convoy to your SW. The red
rectangle indicates how much of the overall situation is
visible on your Main Chart, which is the larger display on
the screen.
In the Jump Chart and on the Main Chart, a number of
circles will be drawn showing various ranges associated with
the selected ship. The yellow circle indicates the maximum visibility from the selected ship, based on
the current conditions. This maximum visibility can change during the battle. The black circle indicates
the maximum range of the main guns on the ship. The ship can only fire at enemy ships when they are
within this circle. When it is present, an orange circle indicates the maximum range of any secondary
guns on the ship, although not all ships have secondary guns. Likewise, if there is a blue circle, then it
indicates the maximum range that torpedoes can be fired, if the ship has torpedoes. If a ship is
equipped with radar, you will also see a purple circle indicating the maximum range of the radar.
When you click on your submarine, you will notice that neither the blue nor black circles are complete.
This indicates that those weapons do not have a full field of fire. The torpedoes can only be fired fore
and aft (front and back), and the deck gun can only be fired to the front ¾ of your ship. (The Conning
Tower blocks the gun from firing aft.) Anti-submarine ships also have various fields of fire for their
Depth Charges, Depth Charge Projectors, Hedgehogs and guns.
Also notice that if you move the mouse to the edge of the screen, then the Main Chart will scroll in that
direction. However, if you click on any ship on the Main Chart, a picture of that ship will appear on
the top left, and the previously selected ship’s image will be pushed down a position.
If you go to the View Menu and click on the Ship/Acft Names entry then the name of each ship will be
drawn on the Main Chart.

If you click on the enemy ship, only certain information will be displayed about that ship in the Ship
List since we are playing with Fog-of-War. In particular, you will only have general information about
the ship’s status such as No Damage, Light Damage, and so on.
The Main Chart has an adjustable scale. There are 5 zoom levels in the game that you can use on the
Main Chart. You can use the View Menu to select the one you wish or use “hot keys” of 1 – 4 on your
keyboard to quickly change view level. You can also use your wheel mouse if you have one.

Most of your important commands are found in the Tool Bar along the top of our screen. You can click
on the Yellow watch icon to slow down the ship, and Green to speed up. The speed is listed as current
speed and ordered speed. So, if you order a ship currently going 5kts to speed up to 8, it will show 5/8,
with the current speed gradually increasing as the ship accelerates. Note: if you rest your mouse over a
button a “tool tip” will be displayed giving the name/function of the button.
It is possible for you to select an individual ship on the chart and click on one of the turn
buttons in the Tool Bar to change the direction it should sail in. You will notice on the Main
Chart that a green arrow appears showing you the new commanded direction. However,
based on the size of the ship, it will take some time for the ship to actually accomplish the
turn and face that direction. Also you should understand that when you change the direction
of a group of ships, that you should issue the turn command only to the flagship. (The
Flagship will have a small white flag on it to denote it’s status.) The other ships in the group will
automatically follow the flagship through the turn. You should avoid issuing commands to individual
ships in a group as this will cause them to become Detached from their group and require that you issue
commands for them separately. Note: In the Alternative Interface you change direction by clicking the
port (left) and star (right) links below the ship image.
There are a number of special commands used for submarine operations in the game. In the center of
the Tool Bar are the depth commands (surface, periscope and fully submerged.) To the left of this are
red buttons which can issue commands to “Inhibit Firing” and “Inhibit Periscope” Inhibit firing will
keep your ship from firing, preventing your gun flash from alerting the enemy. Likewise, Inhibit
Periscope will hide your periscope even though you are at Periscope depth, keeping the enemy from
spotting it. These red buttons will change based on the ship type you have selected.
You can use the 4 watch buttons (red, black, yellow and green) to adjust game speed. You can choose
0x (paused) all the way up to 10x. You can also pause and restart the game using the spacebar.
If a ship is hit during the battle, a message will flash at the top of the Main Chart indicating that hit. If
the hit is on one of your ships, then two numbers will be displayed showing the percentage damage to
the ship as a result of the hit and the remaining status of the ship after the hit.
If you are not currently viewing the ship that was hit, then you can use the Last Hit button on the
toolbar to scroll the Main Chart to the location of that ship.

Note: In some scenarios there is a line running across the chart. This line indicates that one side has a
Line Objective. They will attempt to gain victory points by crossing this line. In those situations your
goal is to use your ships and aircraft to prevent them from accomplishing that.
The bar in the lower right-hand corner of the screen will show you the victory status
of the battle. When there is a blue area showing, then the Allies hold the advantage in
victory points or if there is a red area showing, then the Axis holds the advantage. If your flag appears
there, then you have at least a minor victory and if the entire bar is blue, you have a major victory.
Let's focus on submarine gameplay now. If you do not
already see your submarine (U-107) in the main display,
click on the jump map in the lower left around the red dot.
Then, click on your sub. Look in the ship information area
(top left). If you look at the u-boat image in left box you
will see some information about your sub. In the top left of
the box you'll see 100%(100%). The first number is the
overall health of your boat. That number will be there for all
ships. However, for submarines, there will also be a number in parentheses. That number indicates your
remaining battery charge. The faster you go while submerged, the more quickly you will discharge
your batteries.
Looking at our subs details we find that the
Alternative Interface offers a bit more data at
a glance. The image to the left is a shot from
that view. Just below the name of the
submarine you will see information on your
current loadout. The Type IX-B U-Boat has
4 torpedo tubes forward (Marked with F), 2
aft (marked with A.) The tubes marked X
represent external storage of spare torpedoes
that cannot be accessed in the midst of
battle. You will also note that the forward tube is marked 4/6. That means you have four forward
tubes, and then 6 internal reloads for those tubes. When you fire a torpedo, your crew will
automatically begin the reload process, which takes a set amount of time. After you fire a torpedo, a
third number will come up which is a countdown in seconds until the tube is reloaded.
By way of comparison, in the Classic view you must select
your ship then go to the Command Menu and select “Set Active
Load” in order to bring up a dialog box which brings you the
detailed info on the available weapons on your ship.
The enemy convoy is to your SW, so for now, click once on the
right turn button and turn to SSW. Now click on the black clock
icon to start the game in Normal speed (1x). You are currently
running on the surface, so your view range will be maximized.
Proceed on this course until you make contact. You may wish to
accelerate time for a bit (by clicking the green watch icon), but be ready to pause as soon as contact is
made (by either hitting the space bar or clicking the black clock).

As soon as the enemy is spotted, dive to periscope depth, and continue your
approach. As the convoy zig zags you may need to adjust your course. Notice that
you get different background sounds when you are submerged. This helps remind
you if you are currently surfaced or underwater.
While you are submerged, the pale green lines represent sound bearings to enemy ships, while the
bright green ones represent the enemy active sonar.
From here, you'll want to maneuver your submarine to get into position to get a good shot at the enemy
convoy. The closer the better... however, the escorts are looking for you! Take your shots and see if
you can destroy the cargo ships and maybe an escort to boot...and then dive deep and run for safety.
Now you have your enemy in your sights, but how do you fire? You have a couple of options. For now,
let's focus on using your Target Data Computer (TDC). The details on the TDC are on page 48 of the
main user manual, but mouse over the enemy ship you want to aim at, and hit the Ctrl key. You'll see a
blue line appear. That's your TDC estimate on the enemy ship. If it stays on a constant course and
speed, a torpedo fired along that course should hit the enemy. Otherwise, you can simply try to
"eyeball" the solution. That takes much more practice, as you have to manually estimate how much the
enemy ship will move while your torpedo is in the water. It can be useful for times you expect enemy
ships to turn or the like, but it takes much more practice to get a feel for it.
In my action I got very lucky with my first torpedo salvo and sunk the K class Corvette and started
flooding on one of the merchant ships. From there I was able to sink two more merchants and then
square off with the remaining Frigate escort. I ended by hunting down the lame merchant ship and
sinking her with my deck gun. A very successful ambush, but I exhausted my torpedo supply, which
would then force me to seek re-supply. If this had been a larger convoy I could be in real trouble now...
Now, let's switch over to the British side, and look at ASW (Anti Submarine Warfare) for a moment.
You’ll need to go to the File menu and then choose “Select...” - this will bring up our main dialog
where we can select the Getting Started scenario again. This time though, select Automatic with Fog of
War for the Axis side and Manual for the Allies. Focus your map on the small cluster of 5 blue dots on
the minimap. That's your convoy. You have 2 escorts (Penstemon and Gorleston) escorting three
merchantmen. In most scenarios, the escorts are tied to the convoy until the enemy is spotted. In this
case, they are not, to give you a bit more freedom to experiment.
Click on the Penstemon, and
notice the variety of ASW
weapons you have available.
First off, you have a number
of depth charges, and to fire
then, you crtrl-Rightclick in
the area behind your ship.
Each shot is a single DC, so
you can fire off a number of
DC in a pattern. They will
sink for a time before they
explode.

Then, you have the K-Gun. This is a DC launcher which fires a ways out to the side of the ship, instead
of directly aft. To fire, crtl-rightclick in the firing arcs to either side of the ship. Finally, you have
Hedgehogs, which fire directly forward of your ship.
You have a considerably more difficult job on the ASW side, because you have to figure out where the
submarine is. Since you have some freedom, you may wish to move your Corvette further to the NE,
ahead of the convoy. Speed up to maximum and go searching. When your active sonar spots the sub,
you will see a bright green line on the bearing to the enemy sub. Use that to judge your course to
intercept the sub.
Close in and take him down. It will likely take you a few runs to get the
feel for this.
Remember, you must select your active load and then fire it appropriately.
Your deck guns will fire on their own when they have a target, but you must
select your active ASW load and then fire.
In my first try I had a rough time of it...got close to the sub with the corvette
and all of a sudden a volley of three torpedoes was heading my way! Before
I knew it my ship was broken apart and sinking… so I chased in with my
frigate, only to be met with the same fate. Obviously I have a lot to learn about when it comes to ASW.
I think for my second pass I’ll attempt to go in as a team once I have the contact and come in from each
flank…
You can use the following hot keys in place of various menu and toolbar commands.
Space Bar – Toggle the game between Pause and Normal Speed.
1 – Display Main Chart in Ultra Zoom-Out View.
2 – Display Main Chart in Extreme Zoom-Out View.
3 – Display Main Chart in Zoom-Out View.
4 – Display Main Chart in Normal View.
E – Increase the speed of the selected ship by 1 knot or the selected aircraft by 10 knots.
Alt-E – Increase the speed of the selected ship by 1/10 of a knot or the selected aircraft by 1 knot.
C – Decrease the speed of the selected ship by 1 knot or the selected aircraft by 10 knots.
Alt-C – Decrease the speed of the selected ship by 1/10 of a knot or the selected aircraft by 1 knot.
L – Place a Location Marker at the current location.
W – Set the selected ship or aircraft to full speed.
X – Set the selected ship to full stop or the selected aircraft to minimum speed.
A – Perform a Group Turn counterclockwise (to port) with the currently selected ship.
S – Turn the selected ship counterclockwise (to port). D – Turn the selected ship clockwise (to
starboard).
F - Perform a Group Turn clockwise (to starboard) with the currently selected ship.
N – Jump to the location of the last ship hit.
Z – Toggle the display of the Overlay Chart.
Up Arrow – scroll the map up.
Down Arrow – scroll the map down.
Left Arrow – scroll the map left. Right Arrow – scroll the map right.
F1 – Display the main program help file.
F2 – Display the Parameter Data Dialog.

F3 – Display the Database Dialog.

